
 

 
 
 
 
 

กลุมสาระการเรียนรูการงานอาชีพและเทคโนโลย ี
ง30247  การออกแบบเว็บไซต                                ชั้นมัธยมศึกษาปท่ี 6            
ภาคเรียนท่ี 2  เวลา 40 คาบ                       จํานวน  1.0  หนวยกิต 
                                                

ผูเรียนจะไดรับการพัฒนาใหมีความรู ความเขาใจ ศึกษา วิเคราะห ฝกปฏิบัติ เพื่อใหมีความรูความ
เขาใจ  ตระหนักและเห็นคุณคาในเรื่องตอไปน้ี  หลักการเบื้องตนเกี่ยวกับการสรางเว็บเพจ  ความรูเกี่ยวกับ
อินเตอรเน็ตเบื้องตน, กระบวนการพัฒนาเว็บเพจ, หลักการออกแบบเว็บเพจ, โปรแกรมที่ใชในการสราง    
เว็บเพจ,  เริ่มตนสรางเว็บเพจ, การใชขอความในเว็บเพจ,  การใชภาพกราฟกในเว็บเพจ,  การใชตารางใน  
เว็บเพจ, การเช่ือมโยงเว็บเพจ, การจัดแบงเว็บเพจดวยเฟรมเซต, การสรางเลเยอร,  การใชมัลติมีเดีย      
บนเว็บเพจ, และการอัพโหลดเว็บไซตเขาสูอินเตอรเน็ต  

ใชทักษะกระบวนการเรียนรู  กระบวนการคิด  กระบวนการแกปญหา กระบวนการกลุม  
กระบวนการปฏิบัติ  เพื่อใหเกิดความตระหนักและเห็นคุณคา มีความรู  ความเขาใจ  และมีทักษะในการ
ปฏิบัติงาน   สามารถสรางเว็บเพจเผยแพรขอมูลสูอินเตอรเน็ต หรือสรางสรรคโครงงานการประยุกตใชงาน 
เว็บเพจกับแหลงเรียนรูทองถ่ินไดอยางเหมาะสม    

สามารถและมีคุณลักษณะ มีความรับผิดชอบ และมีคุณธรรมจริยธรรมในการใชงานเทคโนโลยี  การ
วัดและประเมินผลใชวิธีที่หลากหลาย และประเมินตามสภาพจริง  

 
ผลการเรียนรู 
1. มีความรูความเขาใจพื้นฐานของการออกแบบเว็บไซต 
2. บอกหลักการและสามารถออกแบบเว็บไซตได 
3. อธิบายโครงสรางและคําสั่งพื้นฐาน และออกแบบเว็บไซตดวยภาษา HTML เบื้องตนได 
4. มีความรูความเขาใจพื้นฐานการสรางเว็บเพจดวยโปรแกรม Macromedia Dreamweaver 8 
5. มีความรูและทักษะในการสรางตารางบนเว็บเพจ 
6. มีความรูและทักษะในการเช่ือมโยงเว็บเพจ (Link) 
7. มีความรูและทักษะในการจัดแบงหนาเว็บดวยเฟรม (Frame) และการจัดวางเน้ือหาดวย Layer 
8. มีความรูและทักษะในการสรางหัวเว็บไซตและปุมกดดวยโปรแกรม Adobe Photoshop CS3 
9. มีความรูและทักษะในการใสสื่อแบบ Multimedia และสรางภาพเคลื่อนไหวดวยโปรแกรม 

Adobe Flash CS3 
10. มีความรูและทักษะในการอัพโหลดเว็บไซตข้ึนสูอินเตอรเน็ตได 
11. มีความรูและทักษะในการสรางสรรคโครงงานการประยุกตใชงานเว็บเพจกับแหลงเรียนรูทองถ่ิน 

 
รวมท้ังหมด  11  ผลการเรียนรู 
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 คําอธิบายรายวิชาเพ่ิมเติม 

จัดทําโดย : นายธีรชัย  สายรัตน 



 

 
 
 
 

 
ในการเรียนรูบทเรียนบนเครือขายอินเตอรเน็ต เรื่อง การออกแบบเว็บไซตดวยโปรแกรม 

Macromedia Draemweaver 8 กลุมสาระการเรียนรูการงานอาชีพและเทคโนโลยี (สาระเพิ่มเติม) 
ช้ันมัธยมศึกษาปที่ 6 หนวยการเรียนรูที่ 3 ประกอบดวย 7 บทเรียน ดังน้ี 
 ชุดที่ 1 เรื่อง พื้นฐานการสรางเว็บเพจดวยโปรแกรม Macromedia Dreamweaver 8 
 ชุดที่ 2 เรื่อง การสรางตารางบนเว็บเพจ 
 ชุดที่ 3 เรื่อง การเช่ือมโยงเว็บเพจ (Link) 
 ชุดที่ 4 เรื่อง การจัดแบงหนาเว็บดวยเฟรม (Frame) และการจัดวางเน้ือหาดวย Layer 
 ชุดที่ 5 เรื่อง การสรางหัวเว็บไซตและปุมกดดวยโปรแกรม Adobe Photoshop CS3 
 ชุดที่ 6 เรื่อง การใสสื่อแบบ Multimedia และสรางภาพเคลื่อนไหวดวย 

         โปรแกรม Adobe Flash CS3 
ชุดที่ 7 เรื่อง การเผยแพรเว็บไซต (Website Publishing) 
โดยการนําเสนอเน้ือหาเปนขอความ ภาพน่ิง วีดิทัศน นักเรียนสามารถควบคุมและเรียนรูบทเรียนได

ดวยตนเองตลอดการใชงาน ซึ่งทําใหนักเรียนมีสวนรวมในการเรียนและสามารถศึกษาทําความเขาใจบทเรียน
ไดดีย่ิงข้ึน นักเรียนสามารถศึกษาข้ันตอนการใชบทเรียนบนเครือขายอินเตอรเน็ต ไดจากคูมือการใชบทเรียน
บนเครือขายอินเตอรเน็ต มีลําดับข้ันตอนดังน้ี 

1. เขาสูระบบบทเรียนบนเครือขายอินเตอรเน็ต ผานเว็บไซต www.krutheerachai.com โดย 
ระบุช่ือผูใชและรหัสผานที่ครูแจงใหทราบเปนรายบุคคล 

2. ศึกษาจุดประสงคการเรียนรู 
3. ทําแบบทดสอบกอนเรียน เมื่อสงคําตอบระบบจะเฉลยและแจงคะแนนใหทราบ 
4. ศึกษาใบความรูหรือวีดิทัศน 
5. ทําใบงาน เมื่อสงคําตอบระบบจะเฉลยและแจงคะแนนใหทราบ หากทําใบงานไมผานเกณฑการ 

ประเมินรอยละ 80 ใหกลับไปศึกษาใบความรูและวีดิทัศนอีกครั้ง 
6. ทําแบบฝกปฏิบัติ เมื่อสงไฟลช้ินงานผานบทเรียนบนเครือขายอินเตอรเน็ต ครูผูสอนเปนผูตรวจ 

ในภายหลัง และแจงผลการประเมินใหนักเรียนทราบผานบทเรียนบนเครือขายอินเตอรเน็ต เกณฑการ
ประเมินคุณภาพระดับดีข้ึนไปหรือเทียบระดับคะแนนไดไมตํ่ากวารอยละ 80  

7. ทําแบบฝกหัด เมื่อสงคะแนนระบบจะเฉลยและแจงคะแนนใหทราบ หากทําแบบฝกหัดไมผาน 
เกณฑการประเมินรอยละ 80 ใหกลับไปศึกษาใบความรูและวีดิทัศนอีกครั้ง 

8. ทําแบบทดสอบหลังเรียน เมื่อสงคําตอบระบบจะเฉลยและแจงคะแนนใหทราบ หากทํา 
แบบทดสอบหลังเรียนไมผานเกณฑรอยละ 80 ใหกลับไปทบทวนใบความรูและวีดิทัศนอกีครั้ง 

9. ทําการออกจากระบบ 
10. หากมีปญหาหรือขอสงสัยใดๆ ใหสอบถามครูผูสอนทันท ี
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คําแนะนําการใชบทเรียนบนเครือขายอินเตอรเน็ต 

จัดทําโดย : นายธีรชัย  สายรัตน 
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แผนผังเว็บไซตบทเรียนบนเครือขายอินเตอรเน็ต 

หนาแรก/เขาสูระบบ 
ตามรหัสผานที่ครูแจง 

คําแนะนําการใชบทเรียน 
บนเครือขายอินเตอรเน็ต 

จุดประสงค แบบทดสอบกอนเรียน 

ศึกษาใบความรู 
ศึกษาวีดิทัศน 

ใบงาน ผานเกณฑ ไมผานเกณฑ 

แบบฝกปฏิบัติ แบบฝกหัด ไมผานเกณฑ 

ผานเกณฑ 

แบบทดสอบหลังเรียน ไมผานเกณฑ 

ผานเกณฑ แบบทดสอบวัดผลสัมฤทธ์ิ 
ทางการเรียน(หลังเรียน) 

ออกจากระบบ 

จัดทําโดย : นายธีรชัย  สายรัตน 



 

 
 
 
 
 
 

 
1. เขาเว็บไซต www.krutheerachai.com โดยใชเว็บบราวเซอร Google Chrome 
2. กรอกช่ือผูใชและรหัสผาน ใหนักเรียนใชเลขประจําตัวนักเรียน 5 หลักและรหัสผานที่ครูแจง 

ตัวอยางที่ใช ช่ือผูใช 00001 รหัสผาน Std-00001 

3. คลิกปุม  
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

 
ภาพประกอบที่ 1.1 การเขาสูบทเรียน 

 
4. เมื่อเขาสูระบบสําเร็จจะปรากฏช่ือผูใชบนหนาจอ 
5. คลิกเลือกวิชาเรียนการออกแบบเว็บไซต 
 
 
 
 
 
 

 
หนวยท่ี 3 การออกแบบเว็บไซตดวยโปรแกรม Macromedia Dreamweaver 8 
ชุดที่ 1 พ้ืนฐานการสรางเว็บเพจดวยโปรแกรม Macromedia Dreamweaver 8 

 

4 

 พ้ืนฐานการสรางเว็บเพจดวยโปรแกรม Macromedia Dreamweaver 8 

การเขาสูบทเรียน 

 

 1 

 2 

 3 

จัดทําโดย : นายธีรชัย  สายรัตน 



 

 
 
 
 
 
 
 
 
 
 
 

 
ภาพประกอบที่ 1.2 การเลือกวิชาเรียน 

 6. เลือกบทเรียนที่ตองการศึกษา ในที่น้ีเลือกชุดที่ 1 พื้นฐานการสรางเว็บเพจดวยโปรแกรม 
Macromedia Dreamweaver 8 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพประกอบที่ 1.3 เลือกบทเรียนชุดที่ 1 
 
 
 
 1. คลิกเลือกจุดประสงคการเรียนรูที่ 1 

 2. ระบบจะแจงขอมูลการดาวนโหลดไฟลจุดประสงคการเรียนรูที่ 1 ใหคลิกที่ปุมเรียกดู  
3. ใหโหลดเก็บไวในไดรฟ D: คลิก New folder เพื่อสรางโฟลเดอรช่ือบทเรียนชุดที่ 1 แลวกดEnter 
4. ดับเบิ้ลคลิกเขาไปในโฟลเดอรบทเรียนชุดที่ 1 คลิกปุม  

 5. คลิกปุมเริ่มดาวนโหลด  
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จุดประสงคการเรียนรูท่ี 1 

จัดทําโดย : นายธีรชัย  สายรัตน 
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 6. โหลดเสร็จแลวคลิกที่ปุมเปด  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพประกอบที่ 1.4 ข้ันตอนการดาวนโหลดไฟลจุดประสงคการเรียนรูที่ 1 
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 2 

 

 3 

 

 5 

 6 

จัดทําโดย : นายธีรชัย  สายรัตน 
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การสรางเว็บไซตเราสามารถสรางไดจากโปรแกรมที่หลากหลาย โปรแกรม Macromedia 
Dreamweaver 8 เปนโปรแกรมหน่ึงที่มีความสามารถในการสรางเว็บไซต การเรียนรูสวนประกอบและ
อธิบายถึงหนาที่การใชงานสวนประกอบตางๆของโปรแกรม Macromedia Dreamweaver 8 ออกแบบ
และเริ่มตนสรางเว็บไซต ใสขอความและจัดรูปแบบของขอความในเว็บเพจ ตกแตงเว็บเพจดวยรูปภาพ
และกําหนดคุณสมบัติของรูปภาพ และบันทึกหนาเว็บเพจ มีความจําเปนและสําคัญตอการพัฒนาเว็บไซต 
 

 

 
สาระสําคัญ 

 

มีความรูความเขาใจ และมีทักษะเบื้องตนการใชงานโปรแกรม Macromedia 
Dreamweaver 8 

 
ดานความรู (K) 

1. บอกสวนประกอบและอธิบายถึงหนาที่การใชงานสวนประกอบตางๆของ
โปรแกรม Macromedia Dreamweaver 8 ได 

ดานทักษะ/กระบวนการ (P) 
1. ออกแบบและเริ่มตนสรางเว็บไซตไดอยางถูกตอง 
2. ใสขอความและจัดรูปแบบของขอความในเว็บเพจไดอยางถูกตอง 
3. ตกแตงเว็บเพจดวยรูปภาพและกําหนดคุณสมบัติของรูปภาพไดอยางถูกตอง 
4. บันทึกหนาเว็บเพจไดอยางถูกตอง 

ดานคุณลักษณะ (A) 
1. ต้ังใจทํางาน มีนํ้าใจเอื้อเฟอเสียสละ มีระเบียบวินัย มีความซื่อสัตย 
2. รับผิดชอบงานที่ไดรับมอบหมาย 

 

 

 
ผลการเรียนรู 

จุดประสงคการเรียนรู 

 

1.  หนาที่การใชงานสวนประกอบตางๆของโปรแกรม Macromedia Dreamweaver 8 
2.  ออกแบบและเริ่มตนสรางเว็บไซต 
3.  ใสขอความและจัดรูปแบบของขอความในเว็บเพจ ตกแตงเว็บเพจดวยรูปภาพและ 
     กําหนดคุณสมบัติของรูปภาพ 
4.  บันทึกหนาเว็บเพจ 

 

 
สาระการเรียนรู 

จัดทําโดย : นายธีรชัย  สายรัตน 
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1. คลิกเลือกแบบทดสอบกอนเรียนที่ 1 
 
 
 
 
 

 
ภาพประกอบที่ 1.5 การเลือกแบบทดสอบกอนเรียนที่ 1 

 
2. ทําแบบทดสอบกอนเรียนที่ 1 โดยอานคําช้ีแจงใหเขาใจ 

คําช้ีแจง แบบทดสอบกอนเรียนที่ 1 เปนแบบทดสอบแบบปรนัย 4 ตัวเลือก จํานวน 10 ขอ  
ใหคลิกเลือกคําตอบที่ถูกที่สุดเพียงคําตอบเดียว คะแนนเต็ม 10 คะแนน แบบทดสอบน้ีจับเวลาในการทํา
แบบทดสอบ 10 นาท ี

3. คลิกปุม  
 
 
 
 
 

 
 
 

ภาพประกอบที่ 1.6 คําช้ีแจงแบบทดสอบกอนเรียนที่ 1 
 

4. จะปรากฏหนาจอการยืนยันจากระบบ “แบบทดสอบน้ีมีการจํากัดเวลาและสามารถทําได 1  
ครั้ง ทานกําลังจะเริ่มการทําแบบทดสอบครั้งใหม จะดําเนินการตอหรือไม” ใหปฏิบัติดังน้ี 

4.1 ถายังไมตองการทําแบบทดสอบกอนเรียนที่ 1 ใหคลิกปุม  

4.2 ถาตองการทําแบบทดสอบกอนเรียนที่ 1 ใหคลิกปุม  
 

 
 
 
 

ภาพประกอบที่ 1.7 การยืนยันการทําแบบทดสอบกอนเรียนที่ 1 
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แบบทดสอบกอนเรียนท่ี 1  

 

 1 

 

 2 

 3 

 

  4.2 4.1 

จัดทําโดย : นายธีรชัย  สายรัตน 



 

 
 5. แบบทดสอบกอนเรียนจํานวน 10 ขอ โดยนําเมาสไปคลิกที่วงกลมหนาตัวเลือก a, b, c, หรือ d 
ที่ตองการตอบ โดยขอสอบจะมีการสลับขอและสลับตัวเลือกทุกครั้งเมื่อมีการทําแบบทดสอบ 

 6. เมื่อทําแบบทดสอบกอนเรียนที่ 1 เสร็จเรียบรอย คลิกปุม  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพประกอบที่ 1.8 แบบทดสอบกอนเรียนที่ 1 
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จัดทําโดย : นายธีรชัย  สายรัตน 

 5 



 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพประกอบที่ 1.9 แบบทดสอบกอนเรียนที่ 1 (ตอ) 
 

 7. ระบบจะแจงสถานะของการทํางานแบบทดสอบกอนเรียนที่ 1 ใหปฏิบัติดังน้ี 
     7.1 ถาสถานะคําตอบแตละขอมีขอใดขอหน่ึงแสดงคําวา “Not yet answered” แสดงวาทํา 

แบบทดสอบกอนเรียนที่ 1 ไมครบ ใหคลิกปุม  
     7.2 ถาสถานะคําตอบทุกขอแสดงคําวา “Answer saved” แสดงวาทําแบบทดสอบกอนเรียน   

ที่ 1 ครบทุกขอ ใหคลิกปุม  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  ภาพประกอบที่ 1.10  ระบบแจงสถานะการทําแบบทดสอบกอนเรียนที่ 1 
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 6 

 

 

 

7.1 

7.2 

จัดทําโดย : นายธีรชัย  สายรัตน 



 

 
 8. ระบบจะแจงการยืนยัน “คุณกําลังจะออกจากการทําแบบทดสอบ หากออกจากการทํา
แบบทดสอบแลวคุณจะไมสามารถเปลี่ยนแปลงคําตอบได” ใหปฏิบัติดังน้ี 

     8.1 ถาตองการกลับไปแกไขคําตอบใหคลิกปุม  

     8.2 ถาตองการสงคําตอบใหคลิกปุม  
 
 
 
 
 
 
 
  ภาพประกอบที่ 1.11  ระบบแจงการยืนยันการสงแบบทดสอบกอนเรียนที่ 1 
 

 9. เมื่อคลิก  ระบบจะเฉลยแบบทดสอบกอนเรียนที่ 1 วาถูกหรือ
ผิด ใหเลื่อนดูจนครบทั้ง 10 ขอ เมื่อดูเฉลยเสร็จแลวใหคลิกที่ “Finish review” 
 
 
 
 
 
 
 
 

ภาพประกอบที่ 1.12  ระบบเฉลยแบบทดสอบกอนเรียนที่ 1 
  

10. ระบบจะแจงคะแนนที่ได จากน้ันใหคลิกปุม  เพื่อกลับสูบทเรียนถัดไป 
 
 
 
 
 
 
 
 
 

ภาพประกอบที่ 1.13  ระบบแสดงคะแนนแบบทดสอบกอนเรียนที่ 1 
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 8.1 

 8.2 

 10 

จัดทําโดย : นายธีรชัย  สายรัตน 



 

 
 
 
 

1. คลิกใบความรูที่ 1 เพื่อเขาศึกษาเน้ือหาบทเรียน 
2. ระบบจะแจงขอมูลการดาวนโหลดไฟลใบความรูที่ 1 ใหดาวนโหลดเก็บไวในไดรฟ D: โฟลเดอร 

ช่ือ บทเรียนชุดที่ 1 คลิกปุม   

3. เมื่อดาวนโหลดเสร็จแลวคลิกปุม  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพประกอบที่ 1.14  ข้ันตอนการดาวนโหลดไฟลใบความรูที่ 1 
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 เน้ือหาบทเรียน 

 

 

 

จัดทําโดย : นายธีรชัย  สายรัตน 

 1 

 2 

 
3 



 

 

 

 
 

 

 
Macromedia Dreamweaver 8 เปนโปรแกรมสําหรับพัฒนาเว็บไซต ซึ่งมีคุณสมบัติ 

ครอบคลุมต้ังแตการออกแบบและสรางเว็บเพจ การบริหารจัดการเว็บไซต ตลอดไปจนถึงการพัฒนาเว็บ
แอพพลิเคช่ัน โปรแกรมน้ีไดรับความนิยมเปนอยางสูงในบรรดาโปรแกรมประเภทเดียวกันเน่ืองจากคุณสมบัติ
เดนคือใชงานงาย มีเครื่องมืออํานวยความสะดวกในการจัดวางขอความ ภาพกราฟก ตาราง แบบฟอรม 
มัลติมีเดีย รวมทั้งองคประกอบตางๆ ที่ใชโตตอบกับผูชมลงในเว็บเพจไดอยางงายดาย โดยผูใชไมจําเปนตอง
รูจักภาษา HTML, CSS, JavaScript และภาษาสคริปตอื่นๆ ดังน้ันจึงเหมาะสําหรับผูเริ่มตนและผูใชทั่วไป 
นอกจากน้ียังมีคุณสมบัติช้ันสูงอีกมากมายสําหรับนักพัฒนาเว็บไซตมืออาชีพดวยเชนกัน 
 

 
ถึงแม Macromedia Dreamweaver 8 เปนโปรแกรมที่ไมตองใชเครื่องมือที่มีประสิทธิภาพ 

สูงมากนัก แตในการใชงานโดยปกติ เราอาจจําเปนตองใชโปรแกรมอื่นๆ รวมในการทํางานดวย เชน 
โปรแกรมตกแตงภาพ โปรแกรมสรางภาพเคลื่อนไหว (Animation) เปนตน ดังน้ันความตองการของเครื่อง
คอมพิวเตอรข้ันตํ่าที่นํามาสรางเว็บเพจ ควรเปนดังน้ี 
   สําหรับเครื่อง PC    สําหรับเครื่อง Macintosh 
หนวยประมวลผลกลาง Intel Pentium หรือ AMD Athlon 64 Multicore Intel Processor 
(CPU) 
ระบบปฏิบัติการ  Windows XP SP2 (แนะนํา SP3) หรือ Mac OS X 
   Windows Vista Home Premium, v. 10.5.8 หรือ v.10.6 
   Bussiness, Ultimate หรือ Enterprise 
   SP1 หรือ Windows 7 
หนวยความจํา (RAM) 512 MB (แนะนํา 1 GB)   512 MB (แนะนํา 1 GB) 
เน้ือที่ฮารดดิสก  อยางนอย 1 GB    อยางนอย 1.8 GB 
 
ตัวอยางโปรแกรมท่ีใชในการสรางเว็บไซต ดังน้ี 
 Microsoft Expression, Web Designner, Amaya, Macromedia Dreamweaver 8, Editplus, 
Microsoft FrontPage, Mini Fast Web Editor, KompoZor, WordPress เปนตน 
 

 
หนวยท่ี 3 การออกแบบเว็บไซตดวยโปรแกรม Macromedia Dreamweaver 8 
ชุดที่ 1 พ้ืนฐานการสรางเว็บเพจดวยโปรแกรม Macromedia Dreamweaver 8 

 

 

 

13 

จัดทําโดย : นายธีรชัย  สายรัตน 

รูจักกับ Macromedia Dreamweaver 8 

ความตองการเครื่องคอมพิวเตอรท่ีเหมาะสมกับ Macromedia Dreamweaver 8 

 

ใบความรูที ่1 
เรื่องพื้นฐานการสรางเว็บเพจดวยโปรแกรม Macromedia Dreamweaver 8 

 

 



 

 

 
เปดโปรแกรม Macromedia Dreamweaver 8  จะเห็นหนาจอที่เขาใจงายตอการออกแบบและ

ปรับเปลี่ยนไดตามความถนัดของผูใช การออกแบบจะอยูในสวนที่เรียกวาหนา DOCUMENT ซึ่งเปนการงาย
ตอการออกแบบ ข้ันตอนการเขาสูโปรแกรม Macromedia Dreamweaver 8   สําหรับ Windows 7 ทําได
ดังน้ี 

1. คลิกที่ปุม Start 
2. คลิกเลือกคําสั่ง All Programs 
3. คลิกเลือก Macromedia (ภาพประกอบที่ 1.1) 

 

  

ภาพประกอบที่ 1.15 แสดงการเขาสูโปรแกรม Macromedia Dreamweaver 8 
 
4. คลิกเลือกคําสั่ง Macromedia Dreamweaver 8  เพื่อเรียกใชงานโปรแกรม  

(ภาพประกอบที่ 1.2) 

( 
ภาพประกอบที่ 1.16 แสดงการเขาสูโปรแกรม Macromedia Dreamweaver 8 (ตอ) 
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 การเปดใชงานโปรแกรม Macromedia Dreamweaver 8 
 

 

 
   1 

 

 
 2  

 
 3 

 

 
 4 

จัดทําโดย : นายธีรชัย  สายรัตน 
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5. เมื่อคลิกเลือกคําสั่ง Macromedia Dreamweaver 8  โปรแกรมจะเขาสูหนาจอ  
Start Page (ภาพประกอบที่ 1.3) 
 

 

 

 

 
ภาพประกอบที่ 1.17 แสดงหนาจอ Start Page โปรแกรม Macromedia Dreamweaver 8 

 
หนาจอ Start Page มีสวนประกอบที่สําคัญ 3 สวน ดังภาพประกอบที่ 1.3 คือ 

- สวนที่ 1 Open a Recent Item เปดเว็บเพจที่เคยใชงานมาแลว โดยเลือกจากรายช่ือที่ 
แสดงอยู 

- สวนที่ 2 Create New สรางเว็บเพจใหม โดยเลือกประเภทของไฟลชนิดตางๆ ได 
- สวนที่ 3 Create from Samples สรางเว็บเพจใหมจากไฟลตัวอยางที่โปรแกรมได 

เตรียมรูปแบบไวแลว 
ในบทเรียนน้ีเราจะคลิกเลือกที่ HTML ในสวนของ Create New เพื่อสรางเว็บเพจเปลาแบบพื้นฐานข้ึนมา
ใหม จากน้ันจะเขาสูหนาจอเริ่มตนของโปรแกรม Macromedia Dreamweaver 8   
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สวนท่ี  1 

 

 

สวนที ่ 2 
 

 

สวนท่ี  3 

 

 

คลิกถาไมตองการแสดง 
Start Page ในการเปด
โปรแกรมคร้ังตอไป 

 

 

ศึกษาบทเรียนชวยสอน 
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ภาพประกอบที่ 1.18 แสดงสวนประกอบของหนาจอ โปรแกรม Macromedia Dreamweaver 8 
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 สวนประกอบของโปรแกรม Macromedia Dreamweaver 8 

 

 
แถบช่ือโปรแกรม 

 

 
แถบเมนูคําสั่ง คือสวนที่เก็บคําสั่งสําหรับการทํางานตางๆ 

 

แถบ Insert Bar คือทูลบารที่ประกอบไปดวยปุมคําสั่ง 
ที่ใชแทรกออบเจ็คชนิดตางๆ ลงไปในเว็บเพจ 
 

 

 

 

 

แท็บช่ือไฟลเว็บเพจ 

 
 

 

ทูลบาร Document คือแถบเครื่องมือที่รวบรวม 
คําสั่งตางๆ ที่เราจําเปนตองใชงานบอย  ๆ
 

 

 

ปุมยุบ/ยอ/ปดวินโดว Document 

วินโดว Document คือสวนที่ใชสําหรับใสเน้ือหา 
และจัดองคประกอบของเว็บเพจลงไป 
 

 

 

แถบสถานะ Status Bar 
เปนแถบแสดงสถานะของเว็บเพจ  
 

 

 

พาเนล Properties Inspector เปนพาเนลที่เราใชงานมากที่สุด 
โดยจะแสดงคุณสมบัติของออบเจ็คที่กําลังเลือกบนเว็บเพจ 
 

 

 

กลุมพาเนลตางๆ  เปนกรอบเล็กๆ ที่ 
ประกอบดวยเครื่องมือสําหรับใชทํางานตาง  ๆ

จัดทําโดย : นายธีรชัย  สายรัตน 
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ในการสรางเว็บเพจ เราสามารถเลือกมุมมองในการทํางานได 3 มุมมองคือ Design, Code  

และ Code and Design ซึ่งจะชวยใหการสรางเว็บเพจสะดวกรวดเร็วมากย่ิงข้ึน 
 

 
ในมุมมองน้ีวินโดว Document จะแสดงเว็บเพจ 

ในลักษณะคลายกับที่เราเห็นในบราวเซอรไมวาจะเปน 
ขอความ ภาพกราฟก หรือออบเจ็คอื่นๆ โดยที่เราสามารถ 
แกไขและจัดวางเน้ือหาตางๆลงในเว็บเพจไดตามตองการ  
ซึ่งสวนใหญเราจะทํางานในมุมมองน้ี 
 
 

 
 
 
 
 

    ภาพประกอบที่ 1.19 แสดงมุมมอง Design 

ในมุมมองน้ีวินโดว Document จะแสดงเว็บเพจ 
ในรูปของชุดคําสั่งภาษา HTML ที่ถูกสรางข้ึนโดยโปรแกรม 
Dreamweaver หรือเปนคําสั่งที่เราเขียนเพิ่มเขาไปเอง 
นอกจากน้ีก็อาจจะมีคําสั่งสไตลชีต (CSS) และภาษา 
สคริปต (script) ตางๆ ดวยเราสามารถตรวจสอบและ 
แกไขคําสั่งเหลาน้ีไดตามตองการ ซึ่งการแกไขจะสงผล 
กลับไปยังมุมมองออกแบบโดยอัตโนมัติ 
 
 
 
  
 
         ภาพประกอบที่ 1.20 แสดงมุมมอง Code 
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มุมมองการทํางานใน Macromedia Dreamweaver 8 
 

มุมมองออกแบบ (Design View) 

 

 

 
คลิกที่ปุม Design จะปรากฏมุมมองออกแบบ 

มุมมองโคด (Code View) 

 

 

 
คลิกที่ปุม Code จะปรากฏมุมมองโคด 
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 ในมุมมองน้ีวินโดว Document จะแสดงเว็บเพจ 
ทั้งในรูปแบบที่ปรากฏบนบราวเซอร และรูปแบบคําสั่ง 
ภาษา HTML พรอมๆ กัน โดยจะแสดงสวนที่เปนคําสั่งไว 
ดานบนและแสดงเว็บเพจปกติไวดานลาง เพื่อใชในการ 
ออกแบบและตรวจสอบแกไขคําสั่งไปในขณะเดียวกัน 
เราสามารถปรับขนาดพื้นที่ของแตละสวนไดโดยการคลิก 
ลากที่เสนแบงระหวางทั้ง 2 สวน 
 

 

 

        
                   ภาพประกอบที่ 1.21 แสดงมุมมอง Code and Design 

 
 เน่ืองจากเว็บไซตประกอบไปดวยเว็บเพจและไฟลที่เกี่ยวของจํานวนมาก โดยเฉพาะเว็บไซตขนาด

ใหญอาจมีจํานวนนับพันไฟล ดังน้ันเราจึงควรวางแผนลวงหนาวาจะจัดเก็บไฟลเหลาน้ีอยางไร 

     
 

 

 

 
 
 ในตัวอยางขางตนไดสรางโฟลเดอรหลักช่ือ school และสรางโฟลเดอรยอย คือ images , sound , 
button , multimedia และไดสรางไฟลเว็บเพจในโฟลเดอรหลักช่ือ index.html 
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 ไฟลหนาแรกของเว็บไซตตองตั้งช่ือวา index.html หรือ index.php เทานั้น NOTE : 

มุมมองโคดและออกแบบ (Code and Design View) 

 

 

 

คลิกที่ปุม Split จะปรากฏมุมมองโคด 
และออกแบบ 
 

การกําหนดโครงสรางของไฟลและโฟลเดอรในเว็บไซต 

 

   
  

 

  
 

 
 

images 

sound 

button 

multimedia 

index.html 
 

 

โฟลเดอรยอย 
 

  โฮมเพจ 
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สิ่งที่เราควรทําเปนอยางแรกในการสรางเว็บไซตดวย Dreamweaver ก็คือการสราง 

Dreamweaver Site เพื่อที่จะกําหนดช่ือเว็บไซตและระบุโฟลเดอรสําหรับจัดเก็บไฟล โฟลเดอรน้ีจะเปน
แหลงรวมเว็บเพจ ภาพกราฟก และไฟลอื่นๆ ที่เกี่ยวของใหอยูในที่เดียวกัน เพื่อความสะดวกเวลาเราจะอัพ
โหลดเว็บไซตข้ึนสูอินเตอรเน็ต รวมทั้งการบริหารจัดการอื่นๆ โฟลเดอรน้ีอาจอยูที่ใดก็ไดภายในโครงสราง
ไฟลของ  Windows ในเครื่องของเรา โดยจะถือเปนจุดเริ่มตนหรือโฟลเดอรหลัก(root folder) ของ
เว็บไซต จากจุดน้ีเราสามารถสรางโฟลเดอรยอยสําหรับแยกเก็บไฟลตามประเภทหรือตามเน้ือหา (ดังกลาว
แลวในหัวขอกอน) โดยการสรางโฟลเดอรยอยน้ีคุณจะทําในระบบ Windows หรือใน Dreamweaver ก็ได
เชนกัน 

 

 
1. เลือกคําสั่ง Site > New Site จากแถบเมนู 
2. ในไดอะล็อกบอกซ Site Definition for Unnamed Site1 ใหคลิกที่แท็บ Basic 
3. ในหัวขอ Editing Files หนาแรก ใหพิมพช่ือเว็บไซตลงไปที่ชอง What would you  

Like to name your site? แลวคลิกปุม  
4. ในหัวขอ Editing Files, Part2 ใหกําหนด server technology โดยในข้ันตอนน้ีให 

เลือก No, I do not  want to use server technology แลวคลิกปุม               (ยังไมกําหนดเซิรฟเวอร
เทคโนโลยี) 
 

 

 

 

 

 

 

 

 

 
 
ภาพประกอบที่ 1.22 แสดงข้ันตอนการสรางเว็บไซตใหมดวยวิซารด 
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สราง Dreamweaver Site 

สรางเว็บไซตใหมดวยวิซารด 

 

 

 

 

 

 

 
   1 

 

 
   2 

 

 
   3 

 

 

 

 
   4 
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5. ในหัวขอ Editing Files, Part 3 ใหระบุโฟลเดอรหลักที่ใชเก็บขอมูลทั้งหมดของเว็บไซต  
โดยคลิกที่ไอคอน  เพื่อเปดเขาไปในโฟลเดอรที่ตองการ 

5.1 แลวคลิกปุม  (หรือใชวิธีพิมพพาธของโฟลเดอรลงไปเองก็ได)  
5.2 จากน้ันคลิกปุม  (ภาพประกอบที่ 1.9) 

6. หลังจากน้ันจะปรากฏหนาจอของหัวขอ Sharing Files ใหเลือกเปน None (ยังไม 
กําหนด Remote Info) แลวคลิกปุม  

7. จะปรากฏหนาจอ Summary ซึ่งแสดงรายละเอียดของเว็บไซต ใหคลิกปุม  
เพื่อจบการสราง 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

เว็บไซตที่สรางใหมจะถูกเปดใชโดยอัตโนมัติ 
   ภาพประกอบที่ 1.23 แสดงข้ันตอนการสรางเว็บไซตใหมดวยวิซารด 
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   5 
 

 

   5.1 

 

 

   5.2 

 

 

 

 

 
   6 

  

 

 

 

   7 
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เว็บไซตที่สรางใหมจะถูกเปดข้ึนใชงานทันที โดยช่ือจะไปปรากฏที่พาเนล Files (ถาบนหนาจอยังไม
แสดงพาเนล Files ใหเลือกคําสั่ง Windows > File) 

 
 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ภาพประกอบที่  1.24 แสดงข้ันตอนการสรางโฟลเดอรใหม 

 
หลังจากที่คุณสรางเว็บไซตไปแลว ถาตองการเปลี่ยนช่ือหรือรายละเอียดอื่นๆ ของเว็บไซตก็สามารถ

ทําไดดังน้ี 
1. เลือกคําสั่ง Site > Manage Sites จากเมนู  

 
ภาพประกอบที่ 1.25 แสดงข้ันตอนการแกไขเว็บไซต 
 

 
หนวยท่ี 3 การออกแบบเว็บไซตดวยโปรแกรม Macromedia Dreamweaver 8 
ชุดที่ 1 พ้ืนฐานการสรางเว็บเพจดวยโปรแกรม Macromedia Dreamweaver 8 

 

 แกไขเว็บไซต 
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- ในขอ 3 ช่ือเว็บไซตที่ต้ังน้ี เปนชื่อเพื่อใชอางอิงภายในเครื่องของ 
คุณเองเทาน้ัน จึงไมจําเปนตองต้ังตามชื่อโดเมนเนม และไมจําเปนตองเหมือนกับชื่อ
เว็บไซตทิ่จะใชบนอินเตอรเน็ตเซิรฟเวอร (หลังจากที่อัพโหลดเว็บไซตแลว) แตอยางใด 

- ในขอ 5 ถาคุณไมระบุอะไร โปรแกรมจะสรางโฟลเดอรชื่อ 
เดียวกับชื่อเว็บไซตข้ึนมาใหโดยอัตโนมัติ 

- คุณสามารถสรางเว็บไซตโดยเลือกจากโฟลเดอรท่ีมีอยูแลว ซ่ึงถา 
หากในโฟลเดอรดังกลาวมีไฟลตางๆ อยูกอน ไฟลเหลาน้ันก็จะถูกรวมเขามาในเว็บไซตที่
สรางใหมดวย 

- ถาหากคุณไมไดสรางโฟลเดอรเตรียมไวลวงหนา ก็สามารถสราง 
โฟลเดอรใหมสําหรับเว็บไซตไดในข้ันตอนที่ 5 โดยคลิกปุม  ดังรูป แลวต้ังชื่อ
โฟลเดอร จากน้ันดับเบิ้ลคลิกเพื่อเปดเขาไปในโฟลเดอรน้ี แลวคลิกปุม   
 

       คลิกสรางโฟลเดอรใหม 
 

 

 

 

 
 
 

NOTE : 

 

 

 

ต้ังช่ือโฟลเดอร 

 

 

 1 



 

 

2. คลิกช่ือเว็บไซต 
3. คลิกปุม Edit 
4. คลิกแท็บ Advanced 
5. แกไขขอมูลตางๆ ตามตองการ 

เชน ช่ือเว็บไซต (Site name) และโฟลเดอร 
ที่เก็บไฟล (Local root folder) 

6. คลิก  
7. คลิก  

 

 

 

 

 

 

 

 

 

 

 

 

ภาพประกอบที่ 1.26 แสดงข้ันตอนการแกไขเว็บไซต 
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   2 

 

 
   3 

 

 
   7 

 

 
   4 

 

 

   5 

 

 
   6 

 

NOTE : 
   

คุณสามารถสรางเว็บไซตไดหลายๆ ไซต 
 ตามตองการแตจะทํางานไดครั้งละ 1 ไซตเทาน้ัน 
โดยเมื่อจะเปดใชเว็บไซตใดก็เลือกช่ือไซตน้ันจากเมนู 
บนพาเนล Files 
            คลิกเพื่อดูรายช่ือเว็บไซต 

             คลิกเลือกเว็บไซตที่ตองการเปด 

   ภาพประกอบที่ 1.27 แสดงข้ันตอนการเปดใชงานเว็บไซต 
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1. เลือก Modify > Page Properties 
2. คลิกเลือก Title/Encoding 
3. คลิกเลือกภาษา เชน ไทย (Windows) 
4. คลิก  

 

 

 

 

 

 

 

 
 
 

ภาพประกอบที่ 1.28 แสดงข้ันตอนการกําหนดภาษาของเว็บเพจ 
 

 

 

 

 

 

 

 
กอนที่จะเริ่มใสเน้ือหาลงในเว็บเพจ คุณควรกําหนดคุณสมบัติพื้นฐานของเว็บเพจกอน เพื่อจะไดใช

เปนคาเริ่มตนสําหรับการทํางานกับเว็บเพจน้ันตอไป เว็บเพจแตละหนาจะมีคุณสมบัติพื้นฐานเฉพาะตัวซึ่งไม
เกี่ยวของกับไฟลอื่น เชน ช่ือเว็บเพจ (title) , สีพื้น (background color) , ภาพฉากหลัง (background 
image) และสีของขอความประเภทตางๆ เปนตน การกําหนดคุณสมบัติเหลาน้ีทําไดโดยใชคําสั่ง Modify > 
Page Properties หรือกดคีย Ctrl + j หรือคลิกปุม  บนพาเนล Properties Inspector 
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การกําหนดภาษาของเว็บเพจ 

 

 

 

 

 
   1 

 

 
   2 

 

 
   3 

 

 
   4 

 

การกําหนดคุณสมบัติพ้ืนฐานของเว็บเพจ 
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NOTE :   คุณอาจจะใชวิธีคลิกปุม  บน Properties Inspector ก็ได 
  ถาปุมน้ีปรากฏอยู 
 
 
 
 

ภาพประกอบที่ 1.29 แสดงข้ันตอนการกําหนดภาษาของเว็บเพจ (ตอ) 
 

 



 

 

 
1. เลือก Modify > Page Properties 
2. หัวขอ Category เลือก Appearance 
3. หัวขอ Page font : ใหเลือก Microsoft Sans Serif (ซึ่งเปนฟอนตที่นิยมใชกัน) 

3.1 ถาไมมีฟอนตน้ีใหคลิกเลือก Edit Font List เพื่อโหลดฟอนตเพิ่มเขามา 
 
 
 

 

 

 

 

 

3.2 หัวขอ Available fonts: 
ใหเลือกฟอนต Microsoft Sans Serif 
แลวคลิก  ใหฟอนต Microsoft Sans Serif 
มาอยูทางชองซายหัวขอ Chosen fonts: 

3.3 คลิก  
เสร็จแลวมาเลือกตามขอที่ 3 
         3.4 คลิก  
   
     
 
 
 

 

 

 

     

  ภาพประกอบที่ 1.30 แสดงข้ันตอนการกําหนดชุดฟอนตตัวอักษร 
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   1 

 

 
   2 

 

 
   3 

 

 
   3.4 

 

 

 

 

 

 
   3.1 

 

 
   3.2 

 

 
   3.3 
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การกําหนดชุดฟอนตตัวอักษร 



 

 

- Page font  กําหนดชุดฟอนตตัวอักษรที่ตองการใชกับเว็บเพจทั้งหนา  
(Default Font หมายถึงไมระบุฟอนต) 

- Size  ขนาดของตัวอักษร (การกําหนดขนาดตัวอักษรตองระบุหนวย 
เสมอ)  

- Text color   สีของขอความทั่วไป (ไมรวมถึงขอความที่เปนไฮเปอรลิงค) 
- Background color สีพื้นหลังของเว็บเพจ 
- Background image ภาพฉากหลังของเว็บเพจ 
- Repeat  วิธีแสดงภาพฉากหลังแบบซ้ํา  ๆ
- Left margin ระยะขอบของเว็บเพจดานซาย 
- Right margin ระยะขอบของเว็บเพจดานขวา 
- Top margin ระยะขอบของเว็บเพจดานบน 
- Bottom margin ระยะขอบของเว็บเพจดานลาง 

 

 
 หัวเรื่องหรือไตเต้ิล (title) ของเว็บเพจมีความสําคัญมาก เพราะเปนขอความที่ใชแสดงบนไตเต้ิลบาร
ของบราวเซอร ซึ่งเปนสิ่งที่ผูชมเห็นเปนอยางแรกเมื่อเปดดูเว็บเพจน้ัน ขอความน้ีชวยอธิบายวาเว็บเพจน้ันมี
เน้ือหาเกี่ยวของกับอะไรได นอกจากน้ียังเปนขอมูลสําคัญที่ search enqine ใชคนหาเว็บเพจอีกดวย การใส
หัวเรื่องเว็บเพจทําไดหลายวิธี ดังน้ี 
วิธีที่ 1 

คลิกในชอง Title แลว 
พิมพขอความหัวเรื่องลงไป 

 

วิธีที่ 2 
1. คลิกปุม Page Properties 
2. คลิก Title/Encoding 
3. พิมพขอความหัวเรื่อง 
4. คลิก 

 

 

 

 

 
ภาพประกอบที่ 1.31 แสดงข้ันตอนการใสขอความหัวเรื่องเว็บเพจ 
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 การใสขอความหัวเรื่องเว็บเพจ 
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การพิมพขอความในเว็บเพจจะคลายกับการพิมพเอกสารในโปรแกรม Word โดยเราสามารถ

จัดรูปแบบขอความใหสวยงามไดดวย โดยอาจใชตัวอักษรกราฟกที่สีตัวอักษรตัดกับสีพื้นฉากหลัง มีการ
เรียงลําดับยอหนา มีการจัดวางตําแหนงเน้ือหา ซึ่งจะชวยใหเว็บเพจเราดูนาสนใจย่ิงข้ึน 

 
 

 

 

 

 

 

 

 

 

 

ภาพประกอบที่ 1.32 แสดงข้ันตอนการพิมพขอความลงบนเว็บเพจ 
เราสามารถจัดรูปแบบและขนาดตัวอักษรไดโดยใหเลือกขอความที่ตองการปรับแตงและแกไขคา

ตางๆ ไดที่ หนาตาง Properties Inspector โดยมีรายละเอียดตางๆ ดังน้ี 
 

รูปแบบยอหนาของ HTML สไตล CSS  ตัวเอียง 
ตัวหนา  จัดตําแหนงยอหนา 

 

 

 

   ชุดฟอนตตัวอักษร    ขนาดตัวอักษร  สีตัวอักษร    สราง List 
   หนวยของขนาดตัวอักษร  การเย้ืองยอหนา 

ภาพประกอบที่ 1.33 แสดงข้ันตอนการจัดรูปแบบขอความ 
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 การพิมพขอความลงบนเว็บเพจ 
 

 

 
 

คลิกวางเคอรเซอรแลวพิมพขอความ 
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ในการใสขอความลงบนเว็บเพจ คุณอาจจะสังเกตวาเวลาเคาะเวนวรรคหลายครั้งติดๆ กันโปรแกรม

จะไมทําให โดยมันจะเวนวรรคเพียง 1 ครั้งเทาน้ัน วิธีทําใหเวนไดมากกวา 1 ตัวอักษรคือ 
กดคีย         +              +          ชองวางก็จะเพิ่มข้ึนตามจํานวนคลิก 
 

 
โดยปกติเมื่อเราพิมพขอความเต็มบรรทัด (หรือเต็มความกวางของขอบเขตตรงจุดน้ัน) โปรแกรมจะ

ปดขอความข้ึนบรรทัดใหมโดยอัตโนมัติ (การกดคีย Enter จะถือวาเปนการข้ึนยอหนาใหมซึ่งระยะบรรทัดจะ
หางกวาปกติ) แตถาคุณตองการปดขอความข้ึนบรรทัดใหมเอง ทําไดโดย 
กดคีย            +   
 

 
เราสามารถใสรูปภาพที่เตรียมไวแลวในเว็บเพจไดโดย 
1. วางตัวบอกตําแหนงการพิมพในตําแหนงที่จะใสรูปภาพ 
2. เลือกคําสั่ง  Insert > Image 
3. คลิกที่ชอง Look in เพื่อเปดไปยังไดรฟและโฟลเดอรที่เก็บไฟลภาพ 
4. เลือกไฟลรูปภาพที่ตองการ 
5. คลิก 

 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพประกอบที่ 1.34 แสดงข้ันตอนการตกแตงเว็บเพจดวยรูปภาพ 
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การเวนวรรคระหวางขอความ 

Ctrl Shift Space Bar 

การขึ้นบรรทัดใหมในยอหนา 
 

Shift Enter 

การตกแตงเว็บเพจดวยรูปภาพ 
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6. เลือกกอปปไฟลภาพเขามาไวในเว็บไซต โดยคลิก Yes 
7. ดับเบิ้ลคลิกเพื่อเปดเขาไปยังโฟลเดอรยอยที่จะใชเก็บไฟลภาพ (หรือคลิกเลือกโฟลเดอร 

แลวคลิกปุม              ) 
8. คลิกปุม  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพประกอบที่ 1.35 แสดงข้ันตอนการตกแตงเว็บเพจดวยรูปภาพ 

รูปภาพจะปรากฏบนเว็บเพจ และไฟลที่กอปปเขามาเก็บในเว็บไซต ก็จะปรากฏช่ือในโฟลเดอรที่คุณ
กําหนดดวย 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพประกอบที่ 1.36 แสดงข้ันตอนการตกแตงเว็บเพจดวยรูปภาพ (ตอ) 
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รูปภาพที่ได
บนเว็บเพจ 

ไฟลรูปภาพ 
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วิธีตกแตงเว็บเพจใหสวยงามอยางหน่ึง ก็คือการนําภาพมาใสเปนพื้นหลังหรือแบ็คกราวนด 

(Background) ของเว็บเพจ เพื่อสรางความสะดุดตาและนาสนใจ 

 
1. เลือกคําสั่ง Modify > Page Properties… 
2. คลิกหัวขอ Appearance 
3. ในสวนของ  Background image  คลิกที่ปุม              เพื่อเลือกไฟลรูปภาพ 
4. เลือกไฟลรูปภาพที่ตองการนํามาทําพื้นหลังเว็บเพจ 
5. คลิกปุม  
6. คลิกปุม               จะปรากฏรูปภาพที่เราไดเลือกไวแสดงเปนพื้นฉากหลังของเว็บเพจ 

 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

ภาพประกอบที่ 1.37 แสดงข้ันตอนการใสภาพพื้นหลังเว็บเพจ 
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การแสดงภาพพ้ืนหลังเว็บเพจ 

ขั้นตอนการใสภาพพ้ืนหลัง 
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ปรากฏรูปภาพ   
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การบันทึกเปนการจัดเก็บเว็บเพจหลังจากที่เราสรางข้ึนและมีการใสเน้ือหาลงไปแลว (หรือการ

จัดเก็บเว็บเพจเดิมที่ถูกเปดข้ึนมาแกไข) โดยปกติโปรแกรมจะกําหนดใหเว็บเพจมีนามสกุลเปน .htm หรือ 
.html แตหากตองการบันทึกเปนไฟลประเภทอื่นคุณก็สามารถเปลี่ยนแปลงได 

1. เลือก File > Save 
2. เลือกโฟลเดอรที่จะเก็บไฟล 
3. ต้ังช่ือไฟล 
4. (ถาตองการ) เลือกประเภทของไฟลที่จะบันทึก 
5. คลิกปุม  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพประกอบที่ 1.38 แสดงข้ันตอนการบันทึกหนาเว็บเพจ 
 

 
การทดสอบเว็บเพจดวยบราวเซอร สามารถทําไดโดยวิธีใดวิธีหน่ึง ดังน้ี 

วิธีที่ 1 
1. เลือกคําสั่ง File 
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การบันทึกหนาเว็บเพจ 
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การทดสอบเว็บเพจดวยบราวเซอร 
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2. เลือก Preview in Browser 
3. เลือกช่ือโปรแกรมบราวเซอร 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพประกอบที่ 1.39 แสดงข้ันตอนการทดสอบเว็บเพจดวยบราวเซอร 
วิธีที่ 2 

1. คลิกปุม  Preview/Debug in browser บนทูลบาร Document 
2. เลือกช่ือโปรแกรมบราวเซอร 

 
 
 
 
 
 
 
 
 
 

ภาพประกอบที่ 1.40 แสดงข้ันตอนการทดสอบเว็บเพจดวยบราวเซอร (ตอ) 
วิธีที่ 3 
 กดคีย            บราวเซอรดีฟอลต (primary browser) จะถูกเรียกข้ึนมาแสดงเว็บเพจ 
ถาคุณยังไมไดบันทึกไฟลโปรแกรมอาจจะแจงเตือนออกมา ใหคลิก Yes เพื่อบันทึกไฟลกอนมิฉะน้ัน
บราวเซอรจะแสดงขอมูลเดิม 
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 การสรางหนาเว็บเพจใหม เพื่อออกแบบเว็บเพจ ตกแตงและนําไปใชงาน มีข้ันตอนดังน้ี 

1. เลือกคําสั่ง File > New จากเมนู 
2. ในแท็บ General ใหเลือกกลุมของเว็บเพจใหมที่จะสราง 
3. สําหรับการสรางเว็บเพจธรรมดาใหเลือก Basic page 
4. เลือกประเภทของเว็บเพจ เลือก HTML 
5. คลิกปุม  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพประกอบที่ 1.41 แสดงข้ันตอนการสรางเว็บเพจใหม 

 
การเปดเว็บเพจที่บันทึกไวมาเพื่อแกไข ตกแตงเพิ่มเติม มีข้ันตอนดังน้ี 
1. เลือกคําสั่ง File > Open 
2. เลือกโฟลเดอรที่เก็บเว็บไซตและโฟลเดอรยอยที่เก็บไฟล 
3. คลิกเลือกไฟลเว็บเพจ 
4. คลิกปุม  

 
คุณสามารถสรางหรือเปดเว็บเพจข้ึนมาทํางานไดพรอมกันหลายไฟล แตจะแกไขไดทีละไฟล 

โดยเมื่อตองการแกไขไฟลใดก็ใหคลิกเลือกที่แท็บช่ือของไฟลน้ัน หรือเลือกคําสั่ง Window > ชื่อไฟล 
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การสรางเว็บเพจใหม 
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ภาพประกอบที่ 1.42 แสดงข้ันตอนการเปดเว็บเพจ 
 

 
การออกจากโปรแกรม Macromedia Dreamweaver 8 ทําไดหลายวิธี ดังน้ี 

วิธีที่ 1 เลือกคําสั่ง File > Exit 
วิธีที่ 2 คลิกปุม  Close ตรงมุมบนดานขวา 
วิธีที่ 3 กดแปนพิมพปุม           +  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพประกอบที่ 1.43 แสดงข้ันตอนการออกจากโปรแกรม Macromedia Dreamweaver 8 
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การออกจากโปรแกรม Macromedia Dreamweaver 8 

Alt F4 

 

วิธีที่ 1   
วิธีที่ 2   
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1. ศึกษาวีดิทัศน โดยคลิกที่ “วีดิทัศน พื้นฐานการสรางเว็บเพจดวยโปรแกรม Macromedia  
Dreamweaver 8” 
 
 
 
 
 
 
 
 
 
 
    ภาพประกอบที่ 1.44 การเลือกวีดิทัศน 
 

2. การชมวีดิทัศนและการดาวนโหลดวีดิทัศน ใหปฏิบัติดังน้ี 

2.1 ถาตองการชมวีดิทัศน คลิกที่  

2.2 ถาตองการดาวนโหลดวีดิทัศน คลิกที่  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพประกอบที่ 1.45 การชมวีดิทัศนและการดาวนโหลดวีดิทัศน 
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 วีดิทัศน 
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 1 

 2.1 

 2.2 



 

 
 
 
 

1. คลิกเลือกใบงานที่ 1 
 
 
 
 
 
 
 
 

ภาพประกอบที่ 1.46 การเลือกใบงานที่ 1 
 

2. อานคําช้ีแจงใบงานที่ 1 ใหเขาใจและคลิกที่ปุม  เพื่อเริ่มทําใบงานที่ 1 
 

 
 
 
 
 
 
 
    ภาพประกอบที่ 1.47 คําช้ีแจงใบงานที่ 1 
 

3. จะปรากฏหนาจอการยืนยันจากระบบ “แบบทดสอบน้ีมีการจํากัดเวลาและสามารถทําได 1  
ครั้ง ทานกําลังจะเริ่มการทําแบบทดสอบครั้งใหม จะดําเนินการตอหรือไม” ใหปฏิบัติดังน้ี 
      3.1 ถายังไมตองการทําใบงานที่ 1 ใหคลิกปุม  

      3.2 ถาตองการทําใบงานที่ 1 ใหคลิกปุม  
 
 
 
 
 
 
 
    ภาพประกอบที่ 1.48 การยืนยันการทําใบงานที่ 1 
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ใบงานท่ี 1 

 

 

 

จัดทําโดย : นายธีรชัย  สายรัตน 

 1 

 2 

 3.1 
 3.2 



 

 
 
 4. ใบงานที่ 1 เปนแบบทดสอบแบงเปน 2 ประเภท 
     4.1 แบบทดสอบแบบจับคู ใหนักเรียนพิจารณาขอความดานซายมือที่กําหนดให และจับคูกับ
ขอความที่เปนตัวเลือกดานขวามือที่มีความสัมพันธกันมากที่สุด 
     4.2 แบบอัตนัย ใหนักเรียนพิจารณาขอความที่กําหนดใหและพิมพคําตอบที่ถูกตองลงในชองวาง 
     4.3 ทําแบบทดสอบเสร็จแลวใหคลิกปุม  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 5. ระบบจะแจงสถานะของการทําใบงานที่ 1 ของแตละขอดังน้ี 
     5.1 ถาสถานะคําตอบแตละขอมีขอใดขอหน่ึงแสดงคําวา “Incomplete answer” แสดงวาตอบ

ใบงานที่ 1 ไมครบ ใหคลิกปุม  
     5.2 ถาสถานะคําตอบทุกขอแสดงวา “Answer saved” แสดงวาตอบใบงานที่ 1 ครบทุกขอ ให
คลิกปุม  
 
 
 
 
   
 

ภาพประกอบที่ 1.50 ระบบแจงสถานะการทําใบงานที่ 1 
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 ภาพประกอบที่ 1.49 ใบงานที่ 1 

 4.1 

 4.2 

 4.3 

 5.1 

 5.2 

จัดทําโดย : นายธีรชัย  สายรัตน 



 

 
 
 6. ระบบจะแจงการยืนยัน “คุณกําลังจะออกจากการทําแบบทดสอบ หากออกจากการทํา
แบบทดสอบแลวคุณจะไมสามารถเปลี่ยนแปลงคําตอบได” ใหปฏิบัติดังน้ี 

     6.1 ถาตองการกลับไปแกไขคําตอบ ใหคลิกปุม  

     6.2 ถาตองการสงคําตอบ ใหคลิกปุม  
 
 
 
 
 
 
 

ภาพประกอบที่ 1.51 ระบบแจงการยืนยันการสงใบงานที่ 1 

 7. เมื่อคลิก  ระบบจะเฉลยขอสอบวาถูกหรือผิดใหเลื่อนดูจนครบ

ทุกขอ เมื่อดูเฉลยเสร็จแลวใหคลิกที่  
 
 
 
 
 
 
 
 
 
 

 
8. ระบบจะแจงคะแนนที่ได ใหคลิกปุม  เพื่อกลับสูบทเรียนตอไป 
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 6.1 

 6.2 

 ภาพประกอบที่ 1.52 ระบบเฉลยใบงานที่ 1 

 
ภาพประกอบที่ 1.53 ระบบแสดงคะแนนใบงานที่ 1 

จัดทําโดย : นายธีรชัย  สายรัตน 

 7 

 8 



 

 
 
 
 

1. คลิกเลือกแบบฝกปฏิบัติที่ 1 
 
 
 
 
 

 

ภาพประกอบที่ 1.54  การเลือกแบบฝกปฏิบัติที่ 1 
 

2. แบบฝกปฏิบัติที่ 1 ใหนักเรียนศึกษาคําช้ีแจงใหเขาใจและปฏิบัติงาน เมื่อปฏิบัติงานเสร็จ 
เรียบรอย ใหสงงานตามข้ันตอนตอไปน้ี 

2.1 ใหคลิกปุม  
2.2 คลิกปุม Add…( ) 
2.3 คลิกที่ Upload a file คลิกปุม  และเลือกไฟลที่ตองการ 
2.4 คลิกปุม  
2.5 คลิกปุม  เปนการเสร็จสิ้นการสงไฟลงาน 
2.6 เมื่อครูผูสอนตรวจงานเสร็จแลว นักเรียนสามารถดูคะแนนไดที่ “สถานะคะแนน” 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
ภาพประกอบที่ 1.55  ข้ันตอนการสงไฟลงาน 
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แบบฝกปฏิบัติท่ี 1 

 

 1 

 

จัดทําโดย : นายธีรชัย  สายรัตน 



 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
   ภาพประกอบที่ 1.56  ข้ันตอนการสงไฟลงาน (ตอ) 
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 2.1 

 

 

 

 2.2 

2.3 

 2.4 

 2.5 

 2.6 

จัดทําโดย : นายธีรชัย  สายรัตน 



 

 
 
 
 

1. คลิกเลือกแบบฝกหัดที่ 1 
 
 
 
 
 
 

    ภาพประกอบที่ 1.57  การเลือกแบบฝกหัดที่ 1 
 

2. อานคําช้ีแจงแบบฝกหัดที่ 1 ใหเขาใจและคลิกปุม  เพื่อเริ่มทําแบบฝกหัดที่ 1 
 

 
 
 
 
 
 
 
 

ภาพประกอบที่ 1.58  คําช้ีแจงแบบฝกหัดที่ 1 
 

3. จะปรากฏหนาจอการยืนยันจากระบบวา “แบบทดสอบน้ีมีการจํากัดเวลาและสามารถทําได 1  
ครั้ง ทานกําลังจะเริ่มการทําแบบทดสอบครั้งใหม จะดําเนินการตอหรือไม” 

3.1 ถายังไมตองการทําแบบฝกหัดที่ 1 ใหคลิกปุม  
3.2 ถาตองการทําแบบฝกหัดที่ 1 ใหคลิกปุม  
 
 
 
 
 
 
  

ภาพประกอบที่ 1.59  การยืนยันการทําแบบฝกหัดที่ 1 
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แบบฝกหัดท่ี 1 

 

 1 

 

 

 2 

 3.1 

 3.2 

จัดทําโดย : นายธีรชัย  สายรัตน 



 

 
 
 4. ทําแบบฝกหัดที่ 1 โดยปฏิบัติดังน้ี 
     4.1 ใหนักเรียนพิจารณาขอความที่กําหนดใหวาถูกหรือผิด ถาขอความน้ันถูกตองเลือก True ถา
ขอความน้ันไมถูกตองเลือก False 

     4.2 เมื่อทําแบบฝกหัดที่ 1 เสร็จแลวใหคลิกปุม  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพประกอบที่ 1.60  แบบฝกหัดที่ 1  
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จัดทําโดย : นายธีรชัย  สายรัตน 

 4.1 



 

 
 
 
 
 
 
 
 
 
 
 

ภาพประกอบที่ 1.61  แบบฝกหัดที่ 1 (ตอ) 
 
 5. ระบบจะแจงสถานะของการทําแบบฝกหัดที่ 1 ดังน้ี 
     5.1 ถาสถานะคําตอบแสดงคําวา “Not yet answered” แสดงวาแบบฝกหัดที่ 1 ตอบไมครบ 

ใหคลิกปุม  
     5.2 ถาสถานะคําตอบแสดงคําวา “Answer saved” แสดงวาตอบแบบฝกหัดที่ 1 ครบทุกขอ ให

คลิกปุม  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพประกอบที่ 1.62  ระบบแจงสถานะการทําแบบฝกหัดที่ 1  
 

6. ระบบจะแจงการยืนยัน “คุณกําลังจะออกจากการทําแบบทดสอบ หากออกจากการทํา
แบบทดสอบแลวคุณจะไมสามารถเปลี่ยนแปลงคําตอบได” ใหปฏิบัติดังน้ี 
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 4.2 

 5.1 

 5.2 

จัดทําโดย : นายธีรชัย  สายรัตน 



 

 
 
     6.1 ถาตองการกลับไปแกไขคําตอบ ใหคลิกปุม  
     6.2 ถาตองการสงคําตอบ ใหคลิกปุม  
  
      
 
 
 
 
 
 
 

ภาพประกอบที่ 1.63  ระบบแจงการยืนยันการสงแบบฝกหัดที่ 1  
 

 7. เมื่อคลิก  ระบบจะแสดงผลดังน้ี 
     7.1 ระบบเฉลยแบบฝกหัดที่ 1 วาถูกหรือผิด ใหคลิกเลื่อนดูจนครบทุกขอ 
     7.2 เมื่อดูเฉลยเสร็จแลวใหคลิกที่ Finish review 
 
 
 
 
 
 
 
 
 

ภาพประกอบที่ 1.64  ระบบเฉลยแบบฝกหัดที่ 1  
 
 8. ระบบจะแจงคะแนนที่ได ใหคลิกปุม  เพื่อกลับสูบทเรียนตอไป 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพประกอบที่ 1.65  ระบบแสดงคะแนนแบบฝกหัดที่ 1   
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จัดทําโดย : นายธีรชัย  สายรัตน 

 6.1 

 6.2 

 7.1 

 7.2 

 8 



 

 
 
 
 

1. คลิกเลือกแบบทดสอบหลังเรียนที่ 1 
 

 
 
 
 
 
 

ภาพประกอบที่ 1.66  การเลือกแบบทดสอบหลังเรียนที่ 1   
 

2. ทําแบบทดสอบหลังเรียนที่ 1 โดยอานคําช้ีแจงใหเขาใจ 
คําช้ีแจง แบบทดสอบหลังเรียนที่ 1 เปนแบบทดสอบแบบปรนัย 4 ตัวเลือก จํานวน 10 ขอ  

ใหคลิกเลือกคําตอบที่ถูกที่สุดเพียงคําตอบเดียว คะแนนเต็ม 10 คะแนน แบบทดสอบน้ีจับเวลาในการทํา
แบบทดสอบ 10 นาท ี

3. คลิกปุม  
 
 
 
 
 
 

ภาพประกอบที่ 1.67  คําช้ีแจงแบบทดสอบหลังเรียนที่ 1   
 

4. จะปรากฏหนาจอการยืนยันจากโปรแกรม “แบบทดสอบน้ีมีการจํากัดเวลาและสามารถ ทําได  
1 ครั้ง ทานกําลังจะเริ่มการทําแบบทดสอบครั้งใหม จะดําเนินการตอหรือไม” ใหปฏิบัติดังน้ี 

4.1 ถายังไมตองการทําแบบทดสอบหลังเรียนที่ 1 ใหคลิกปุม  

4.2 ถาตองการทําแบบทดสอบหลังเรียนที่ 1 ใหคลิกปุม  
 

 
 
 
 
 

ภาพประกอบที่ 1.68  การยืนยันการทําแบบทดสอบหลังเรียนที่ 1   
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 แบบทดสอบหลังเรียนท่ี 1 

 

 

 

จัดทําโดย : นายธีรชัย  สายรัตน 

 1 

 2 

 3 

 4.1  4.2 



 

 
 
 5. ทําแบบทดสอบหลังเรียนที่ 1 จํานวน 10 ขอ โดยคลิกที่วงกลมหนาตัวเลือก a, b, c, หรือ d ที่
ตองการ โดยขอสอบจะมีการสลับขอและสลับตัวเลือกทุกครั้งเมื่อมีการทําแบบทดสอบ 
 6. เมื่อทําแบบทดสอบหลังเรียนที่ 1 เสร็จแลว คลิกปุม  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพประกอบที่ 1.69  แบบทดสอบหลังเรียนที่ 1   
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จัดทําโดย : นายธีรชัย  สายรัตน 

 5 



 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพประกอบที่ 1.70  แบบทดสอบหลังเรียนที่ 1  (ตอ) 
  

7. ระบบจะแจงสถานะของการทําแบบทดสอบหลังเรียนที่ 1 ใหปฏิบัติดังน้ี 
    7.1 ถาสถานะคําตอบแตละขอมีขอใดขอหน่ึงแสดงคําวา “Not yet answered” แสดงวาตอบ

แบบทดสอบหลังเรียนที่ 1 ไมครบ ใหคลิกปุม  
    7.2 ถาสถานะคําตอบทุกขอแสดงคําวา “Answer saved” แสดงวาตอบแบบทดสอบหลังเรียน

ที่ 1 ครบทุกขอ ใหคลิกปุม  
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพประกอบที่ 1.71  ระบบแจงสถานะการทําแบบทดสอบหลังเรียนที่ 1    
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จัดทําโดย : นายธีรชัย  สายรัตน 

 6 

 7.1 

 7.2 



 

 
  
 8. ระบบจะแจงการยืนยัน “คุณกําลังจะออกจากการทําแบบทดสอบ หากออกจากการทํา
แบบทดสอบแลวคุณจะไมสามารถเปลี่ยนแปลงคําตอบได” ใหปฏิบัติดังน้ี 
     8.1 ถาตองการกลับไปแกไขคําตอบใหคลิกปุม  

     8.2 ถาตองการสงคําตอบใหคลิกปุม  
 
 
 
 
 
 
 

ภาพประกอบที่ 1.72  ระบบแจงการยืนยันการสงคําตอบ 
 

 9. เมื่อคลิก  ระบบจะเฉลยแบบทดสอบหลังเรียนที่ 1 วาถูกหรือผิด 
ใหเลื่อนดู ใหเลื่อนดูจนครบทั้ง 10 ขอ เมื่อดูเฉลยเสร็จแลวใหคลิกที่ “Finish review” 
 
 
 
 
 
 
 

ภาพประกอบที่ 1.73  ระบบเฉลยแบบทดสอบหลังเรียนที่ 1 
 
 10. ระบบจะแจงคะแนนที่ได ใหคลิกปุม  เพื่อกลับสูบทเรียนตอไป 
 
 
 
 
 
 
 
 
 
 

ภาพประกอบที่ 1.74  ระบบแสดงคะแนนแบบทดสอบหลังเรียนที่ 1 
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จัดทําโดย : นายธีรชัย  สายรัตน 

 8.1 

 8.2 

 9 

 10 



 

 
 
 
 

1. การออกจากบทเรียน ใหคลิกที่ “หนาหลัก” 
2. คลิก “(ออกจากระบบ)” 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพประกอบที่ 1.75 การออกจากบทเรียน 
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การออกจากบทเรียน 

 

จัดทําโดย : นายธีรชัย  สายรัตน 

 1 

 2 
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 บรรณานุกรม 

จัดทําโดย : นายธีรชัย  สายรัตน 
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ภาคผนวก 

จัดทําโดย : นายธีรชัย  สายรัตน 



 

 
 
 
 
 
 

ขอ คําตอบ 

1 a 

2 a 

3 d 

4 b 

5 a 

6 c 

7 c 

8 a 

9 b 

10 a 
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 เฉลยแบบทดสอบกอนเรียนท่ี 1 

จัดทําโดย : นายธีรชัย  สายรัตน 
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เฉลยใบงานท่ี 1 

 

 

คําตอบ คําถาม 

คําตอบ 

จัดทําโดย : นายธีรชัย  สายรัตน 
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 เฉลยแบบฝกปฏิบัติท่ี 1 

 

จัดทําโดย : นายธีรชัย  สายรัตน 



 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

( ข้ึนอยูกับการออกแบบของนักเรียน ) 
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เฉลยแบบฝกปฏิบัติท่ี 1 (ตอ) 

 

จัดทําโดย : นายธีรชัย  สายรัตน 



 

 
 
 
 
 
 
 
 
 
 
 
 

 
หนวยท่ี 3 การออกแบบเว็บไซตดวยโปรแกรม Macromedia Dreamweaver 8 
ชุดที่ 1 พ้ืนฐานการสรางเว็บเพจดวยโปรแกรม Macromedia Dreamweaver 8 

 

55 

 เฉลยแบบฝกหัดท่ี 1 

 

 

จัดทําโดย : นายธีรชัย  สายรัตน 

คําตอบ 

คําถาม 
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 เฉลยแบบฝกหัดท่ี 1 (ตอ) 

 

จัดทําโดย : นายธีรชัย  สายรัตน 



 

 
 
 
 
 
 

ขอ คําตอบ 

1 b 

2 c 

3 d 

4 c 

5 c 

6 b 

7 d 

8 d 

9 a 

10 d 
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เฉลยแบบทดสอบหลังเรียนท่ี 1 

จัดทําโดย : นายธีรชัย  สายรัตน 



 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 ชื่อ   นายธีรชัย  สายรัตน 
 วัน เดือน ป เกิด  4 ธันวาคม 2515 
 ท่ีอยูปจจุบัน  1 หมูที่ 7 ตําบลสําโรง อําเภอเมือง จังหวัดสุรินทร 
 ประวัติการศึกษา ศึกษาศาสตรมหาบัณฑิต (ศษ.ม.) สาขาวิชาการบริหารการศึกษา 
    จากมหาวิทยาลัยรามคําแหง 
    ครุศาสตรบัณฑิต (ค.บ.) วิชาเอกคอมพิวเตอรศึกษา  

จากสถาบันราชภัฏจันทรเกษม 
 รับราชการ  เริ่มรับราชการเมื่อ 2 พฤศจิกายน 2552 ตําแหนงครูผูชวย โรงเรียนครบุร ี
    จังหวัดนครราชสีมา สังกัดองคการบริหารสวนจังหวัดนครราชสีมา 
    ปจจุบัน ตําแหนง ครู วิทยฐานะ ครูชํานาญการ โรงเรียนครบุร ี
    จังหวัดนครราชสีมา สังกัดองคการบริหารสวนจังหวัดนครราชสีมา 
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ประวัติผูจัดทํา 

 

จัดทําโดย : นายธีรชัย  สายรัตน 


